S4 Training Modules GeoDa: Spatial Regression

Spatial Regression with GeoDa

This lab includes discussion of two types of models of spatial dependence

1) Spatial lag
2) Spatial error

It then shows how to estimate simple spatial regression models in GeoDa

1) Classical OLS regression with diagnostics
2) Spatial lag model vs. Spatial error model

Data and Shapefiles:

We will use a US 2000 Census data for Manhattan in New York City. The zipped data

file is on the S4 Training page and can be downloaded from

http://www.s4.brown.edu/S4/about.htm click on S4 tutorials; scroll down to GeoDa 3.

The shapefile newyork.shp is the map of Manhattan in New York City with Census
2000 data from summary file 3. These are socioeconomic attributes for 297 Census

tracts. It includes the following variables:

Vraiable name Label

POLYID Polygon ID

STATE State FIPS

COUNTY County FIPS

TRACT Census Tract ID

sctrct00 FIPSID

hvalue Median housing value

t0_pop Total population

pctnhw Percent non-Hispanic white persons
pctnhb Percent non-Hispanic black persons
pcthsp Percent Hispanic persons

pctasn Percent Asian persons

tOp_own Percent homeowners

tOp_coll Percent college educated

tOp_prf Percent of people employed in professional/managerial occupations
tOp_uemp Percent of people unemployed
tOp_for Percent foreign born persons

tOp_rec Percent recent immigrants

t0_minc Median household income

tOp_poor Percent total population below poverty
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1. Standard linear regression - Ordinary Least Squares (OLS)

The general purpose of linear regression analysis is to find a (linear) relationship
between a dependent variable and a set of explanatory variables:

y=Xp+e¢

The method of ordinary least squares (OLS) estimation is referred to as a Best Linear
Unbiased Estimator (BLUE). The OLS estimates £ by minimizing the sum of squared
prediction errors, hence, least squares. In order to obtain the BLUE property and make
statistical inferences about the population regression coefficients from the estimated b,
certain assumptions about the random error of the regression equation need to be made.
These include:

a) the random errors have a mean of zero (there is no systematic misspecification or bias
in the population regression equation);

b) the random errors have a constant variance (homoskedasticity) and are uncorrelated;
¢) the random errors have a normal distribution.

2. Spatial dependence

These assumptions may not be always satisfied in practice. When a value observed in
one location depends on the values observed at neighboring locations, there is a spatial
dependence. And spatial data may show spatial dependence in the variables and error
terms.

Why should spatial dependence occur? There are two reasons commonly given. First,
data collection of observations associated with spatial units may reflect measurement
error. This happens when the boundaries for which information is collected do not
accurately reflect the nature of the underlying process generating the sample data.

A second reason for spatial dependence is that the spatial dimension of a social or
economic characteristic may be an important aspect of the phenomenon. For example,
based on the premise that location and distance are important forces at work, regional
science theory relies on notions of spatial interaction and diffusion effects, hierarchies of
place and spatial spillovers.

There are two primary types of spatial dependence:
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a. Spatial error -the error terms across different spatial units are correlated
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With spatial error in OLS regression, the assumption of uncorrelated error terms is
violated. As a result, the estimates are inefficient. Spatial error is indicative of omitted
(spatially correlated) covariates that if left unattended would affect inference.
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b. Spatial lag- the dependent variable y in place i is affected by the independent
variables in both place i and j.

A

With spatial lag in OLS regression, the assumption of uncorrelated error terms is
violated; in addition, the assumption of independent observations is also violated. As a
result, the estimates are biased and inefficient. Spatial lag is suggestive of a possible
diffusion process — events in one place predict an increased likelihood of similar events
in neighboring places.

GeoDa provides a range of diagnostics to detect spatial dependence. It also provides
unbiased regression estimates using a Maximum Likelihood approach (ML Spatial Lag
or Spatial Error models).

3. Spatial regression in GeoDa
Start a project and create weights matrix

a. Start GeoDa by Click the Start > Programs > Instructional Tools >
GeoDa,

b. Go to File > Open Project .
c. Browse through the folder to find and select the shape file, newyork.shp.

d. Select POLYID as the “Key Variable” (by scrolling and clicking on variable name). The
Key Variable must have a unique value for each observation (i.e., in this case Census
tract). The unique value is used to implement the link between maps and statistical
graphs.

e. Click OK. Your screen should now look something like ...
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f. Create a weights matrix. Goto Tools > Weights > Create to open the

Creating Weights dialogue box.

" GeoDa 0.9.5-i (Beta) - brooklyn-new
File Yiew Edt | Tools Table Map Explore Space Redress Options ‘Window Help

| A e e | e |

DataExport » ;
Properties

In the Creating weights dialogue box:

Select newyork.shp as the input, type “rook” in the Save output as (the default
extension is .gal), Select POLYID as the ID variable for the weights file.

Select Rook Contiguity, click Create, then Done.

3.1. Classical OLS regression with diagnostics.

Now, we are ready to perform an OLS regression and evaluate the spatial dependence in
this regression.

a. On the menu bar, choose Regress. A dialogue box will appear:
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Regression Title & Output il

Fiepart Title
IHEGHESSIDN

Output file name
IHeglessiun.DLS

Information in the output includes:
[ Predicted ¥alue and Residual

[ Coefficient ¥ariance batriz

Cancel |

This box inquires the information to be included in the output results. Check Moran’ s
I z-value asshown, and click OK.

b. A variable selection box will appear:

Recresston x|

Select Wariables Dependent 4 ariable
POLYID > | |TOP_OwM
STATE J I
%EETW |ndependent Y arnables
SCTRCTO0 Egmﬂgv’
HWaLUE
TO POF Ll TOP_COLL
FCTHSP TOP_LUEMP
PCTASM il TOP_FOR
TOP_PRF TOMINC
TOF_NAT Ll TOP_POOR
TOP_REC _l
44
v Include constant term
v “weight Files
C:hrook. GAL EI
— Modelz
' [Classic {~ Spatial Lag ™ Spatial Error

Bun Save |

Cancel I Fezet | 1]

In this example, we will predict neighborhood homeownership with several indicators,
including % non-Hispanic white, % non-Hispanic black, % college+ educated,
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unemployment rate, % foreign born, median household income, and % person below
poverty.

Browse to locate the weights matrix file you just created and check the weight Files
box.

c. Check classic- this will run classical OLS regression with spatial dependence
diagnostics, click Run. When done, click OK.

d. A new window of regression output will appear, and it has several sections.
1) The first section is the summary output of OLS regression:

f:v". GeoDa 0.9.5-i {(Beta) - [Regression.0OLS]
"1 File Wiew Edit Tools Table Map Explore Space Regress Window Help

| @lal|| & slwdue| | (|28 w8lm] || F [l o] @] -4k || mE)
|REGRESSION
SUMMARY OF OUTPUT: OEDINARY LEAST SQUARES ESTIMATION
Data set : newyorkl
Dependent Variabkle : TOP_OWH HNumber of Observations: 287
Mean dependent wvar 15. 487 MNumber of Variakles g =3
3.D. dependent wvar : 18.7788 Degrees of Freedom g zZ89
RE-squared : 0.49540% F-statistic : 40.5344
Adjusted R-zquared 0.483187 Prob(F-=stati=stic) 1. A2532=—-039
Sum squared rezidual: 52848.3 Leog likelihood : -11%0.87
Sigma-square : 182.866 &akaike info critericn : 2397.74
5.E. of regression 13.5228 Schwarz criterion . 2427.209
Sigma-square ML . 177.94
5.E of regression ML: 13.3394
Variable Coefficient Std.Error t-statistic Probability
CONBSTANT —-0.1177227 4.4975895 -0.0z28l748 0.2790785
PCTHNHW 0.3275164 0.08210561 3.988964 0.0000G42
PCTHHE 0.1429145 0.049442326 2.8904323 0.0041380
TOP_COLL -0.25659445 0.0814599 —-3.154245 0.0017787
TOP_UEMP 0.1173606 0.1104465 1.062601 0.25888514
TOP_FOR 0.06%952368 0.06435452 1.080316 0.280%2013
TO MINC 0.000Z293414 4.48%0%4=-005 6.536152 pD.oooooan
TOEP POOR -0.2369754 0.1065372 -2.224373 0.026825%9

It first shows general information of the run, including the mean and standard deviation
of the dependent variable, the model coefficient of determination, F-test probability,
and Log likelihood. Then, the coefficients, standard errors, and significance are shown.
We can see that among the seven indicators, % non-Hispanic white, % non-Hispanic
black, % college+ educated, and median household income are positively related to
homeownership; while poverty rate is negatively related to homeownership; and
unemployment rate and % foreign born have insignificant effects.

2) The next section deals with regression diagnostics:
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REGRESSTON DIAGHOSTICS

MULTICOLLINEARITY COWNDITION MNUMEER 158. 18592

TEST ON NORMALITY OF ERRORE

TEST DF WALUE PROB
Jargque—-Bera 2 1155.541 0O.o0000000

GeoDa tests multicollinearity of the model- one should be alarmed when
MULTICOLLINEARITY CONDITION NUMBER is greater than 20. The Jarque-Bera test
is used to examine the normality of the distribution of the errors. This test is a test of the
combined effects of both skewness and Kurtosis. The low probability of the test score
indicates non-normal distribution of the error term. Since the following tests of variance
and spatial dependence are conditioned upon normal distribution, in real research, one
should be very cautious to interpret the test results. Here, we simply give the illustration
of how to interpret the diagnostics when non-normality is not encountered.

3) DIAGNOSTICS FOR HETEROSKEDASTICITY- atest of the variance of the error
term as the BLUE requires constant error variance.

DIAGHOSTICS FOR HETEROSKEDASTICITY

RAMNDOM COEFEFICIENTS

TEST DF WATLTE FEOEBE
Breusch-Pagan test 7 102,359 O.0000000
Koenker-Bassett test 7 15. 45208 0.0lo00e18
SPECIFICATION EOBUST TEST

TEST DF VALUE PROE
White 35 185.7326 O.00o0000o0

The low probabilities of the three tests point to existence of heteroskedasticity. This is
not necessarily a surprise because the error variance could well be affected by the spatial
dependence in the data.

4) DIAGNOSTICS FOR SPATIAL DEPENDENCE

DIAGHOSTICS FOR SPATTIAL DEPENDENCE

FOR WEIGHT MATRIX : rook.GAL (row-standardized weights)

TEST MI/DF VALUE PROB

Moran's I (error) 0.1%6095 5.7432854 pD.000000D
Lagrange Multiplier (lag) 1 21.5140684 0.0000035
Robust LM (lag) 1 0.1141221 0.7354981
Lagrange Multiplier (error) 1 27.8417603 0.0000001
Robust LM (error) 1 £.4418140 0.0111465
Lagrange Multiplier (SARMA) 2 27.9558824 0.0000009

=== END OF REPORT =

There are six tests performed to assess the spatial dependence of the model. First,
Moran’s | score of 0.196 is highly significant, indicating strong spatial autocorrelation of
the residuals. In addition, the function reports the estimates of tests chosen among five
statistics for testing for spatial dependence in linear models. The statistics are the
simple LM test for a missing spatially lagged dependent variable (Lagrange Multiplier
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(lag)), the simple LM test for error dependence (Lagrange Multiplier (error)), variants of
these robust to the presence of the other (Robust LM (lag) and Robust LM (error)-
which tests for error dependence in the possible presence of a missing lagged dependent
variable, Robust LM (lag) is the other way round), and a portmanteau test (SARMA, in
fact Lagrange Multiplier (error) + Robust LM (lag)).

We can see both simple tests of the lag and error are significant, indicating presence of
spatial dependence. The robust tests help us understand what type of spatial
dependence may be at work. The robust measure for error is still significant, but the
robust lag test becomes insignificant, which means that when lagged dependent variable
is present the error dependence disappears.

3.2. Spatial lag model vs. spatial error model

After identifying the presence of spatial dependence, we will use GeoDa to re-estimate
the model with maximum likelihood approach while controlling for the spatial
dependence.

a. On the menu bar, choose Regress. Check Moran’s I z-value in the output box,
and click OKk.

b. In the variable selection box, set dependent and independent variables as before.
Check weight Files, and browse to locate the weights matrix file.

c. Check spatial Lag in the Models selection, and click Run.

RecressToN x|
Select Variables Dependent Yariable
POLYID » | |TOP_OWwN
STATE —| I -
%EEETW Independent ¥ ariables
SCTRCTAD Egm‘é\’
HvaLUE
T0 POP j TOP_COLL
PCTHSP TOP_UEMP
PCTASH T0F_FOR
TOP_PRF _l TO_MINC

TOP MAT Ll TOF_POOR

R
TOP_REC
|

¥ Include constant term

IV wieight Files
[ ook, GaL =3
— Models
" Classic ¢ Spatial Lag ~ Spatial Emror
Bur |

Compute Spatial Lag

LCancel | Reget | (]9 |
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d. Check spatial Error and click Run. Then click OK.

e. Two new windows of regression output will appear, and they present results for both
spatial lag and spatial error models.

1) First, we see the results from spatial lag model. Again, it consists of multiple sections
and begins with general information and regression coefficients with significance tests.

REGRESSTON

SUMMARY OF OUTPUT: SPATIAL LAG MODEL - MAXITMUM LIKELITHOOD ESTIMATION

Data set : newyorkl

Spatial Weight : rook.GAL

Dependent Variable : TOP OWH HNumber of Observations: 297

Mean dependent wvar 18.487 MNumber of Variables : 9

3.D. dependent var : 18.7788 Degree=z of Freedom : 288

Lag coeff. (Rho) H 0.244682

E-squared : 0.526532 Log likelihood : -1183.22

8q. Correlation - Akaike info criterion : 2384. 44

Sigma-square : 166. 965 Schwarz criterion : 2417. 69

8.E of regreszsszion : 12. 9215
Variable Coefficient Std.Error z-value Probability

W_TOP_OWN 0.244/815 0.070833979 3. 446228 0.0005686
CONSTANT -2.435339 4,334687 -0.5618259 0.574234¢6
PCTMHT 0.2850341 0.08021075 3.598947 0.00031%&
PCTNHE 0.143811% 0.047325972 3.03851 0.0023776
TOP_COLL -0.238261 0.07828735 -3.043416 0.0023392
TOP_UEMP 0.1286424 0.1lo55521 1.218757 0.2229365
TOP_FOR 0.08310842 0.06151475 1.351032 0.1766852
TO_MINC 0.000Z427569 4,351055e-005 5.528442 0.0000000

TOP POCR -0.2224669 0.1lo0z0317 -zZ.18037 0.0z92299

Notice, besides the information that appeared in previous OLS regression output, we
have a designated spatial weight file: rook.GAL. And the spatial lag term of
homeownership W_TOP_OWN appeared as an additional indicator. (Its coefficient
parameter (Rho) reflects the spatial dependence inherent in our sample data, measuring
the average influence on observations by their neighboring observations.) It has a
positive effect and it is highly significant. As a result, the general model fit improved, as
indicated in higher values of R-squared and Log likelihood. The effects of other
independent variables remain virtually the same.

2) The following sections show tests of Heteroskedasticity and Spatial dependence.
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REGRESSTON DIAGHOSTICS

DIAGHNOSTICS FOR HETEROSKEDASTICITY

BANDOM COEFFICIENTS

TEST DF’ VALUE PROB
Breusch-Pagan test 7 104.1549 0.ooo0o0o000

DIAGNOSTICS FOR SPATIAL DEPENDENCE

SPATIAL LAS DEPENDENCE FOR WEIGHT MATRIX : rook.GAL

TEST DF VALUE PROB

Likelihood Ratioc Test 1 15.29485 0.0000%20
=== ==== END OF REFORT ===

We can see that the low probability in the Breusch-Pagan test suggests that there is still
Heteroskedasticity in the model after introducing the spatial lag term. And in the
Likelihood Ratio Test of Spatial Lag Dependence, the result is still significant. Therefore,
we conclude that although the introduction of spatial lag term improved the model fit, it
didn’t make the spatial effects go away.

3) Now let’s review results for the Spatial Error model.

REGRESSTOH
SUMMARY OF OUTPUT: SPATIATL. ERFOR MODEL - MAXTMUM LIKELITHOOD ESTIMATIOHN
Data set : newyorkl
Spatial Weight : rook.GAL
Dependent Variable TOP OWN Number of Observations: 297
Mean dependent var 15.487003 HNumber of Variables : g
2.D. dependent wvar : 18.778784 Degree of Freedom 289
Lag coeff. (Lambda) : 0.299826
R-squared : 0.533847 R-sguared (BUSE) H=
5q. Correlaticn 0 = Log likelihood :-1181. 858166
Sigma-square : 144.385385 Akaike info criterion : 2379.72
8.E of regression : 12.8213 Schwarz criterion 1 2409.266190
Variable Coefficient std.Error z-value Probability
CONSTANT -0.5642749 4.471026 -0.126207 0.8995680
PCTHNHW 0.3535008 0.07917054 4.465055 0.0000080
PCTNHE 0.16686377 0.055126928 3.055188 0.0022493
TOP_COLL -0.2548309 0.08248667 -3.089358 0.0020060
TOP_UEMP 0.1141496 0.1054046 1.082966 0.2788234
TOP_FOR 0.08328652 0.06332542 1.3145859 0.1885440
TO MINC 0.0002531006 4.596173e-005 5.506767 0.0000000
TOP_POCR -0.2535857 0.1014521 -2.498575 0.0124p%4
LAMEDA 0.2998257 0.08042689 3.727928 0.0001531

In comparison with the Spatial Lag model output, we also have a designated spatial
weight file: rook.GAL. And a coefficient on the spatially correlated errors (LAMBDA) is
added as an additional indicator. It has a positive effect and it is highly significant. As a
result, the general model fit improved, as indicated in higher values of R-squared and
Log likelihood. Like the lag model, the effects of other independent variables remain
virtually the same.
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4) Diagnostics of Heteroskedasticity and spatial independence

REGRESSTON DIAGHOSTICS

DIAGNOSTICS FOR HETEROSKEDASTICITY

RANDOM COEFFICIENTS

TEST DFE VALUE PROB
Breusch-Pagan test 7 114.8241 0.o0000000

DIAGNOSTICS FOR SPATIAL DEPENDENCE

SPATIAL ERROR DEPENDENCE FOR WEIGHT MATRIX : rook.GAL

TEST DF VALUE PROB
Likelihood Ratic Test 1 153. 02336 o.0000z21s

Similar to the lag model, the Heteroskedasticity test remains significant. Also, the
Likelihood Ratio Test of Spatial Error Dependence has a significant result. Therefore, we
conclude that although allowing the error terms to be spatially correlated improved the
model fit, it didn’t make the spatial effects go away.

5) What should we conclude?

Comparing the spatial lag and spatial error models, we can see both alternative models
yield improvement to the original OLS model. Therefore, we should conclude that
controlling spatial dependence will improve our model performance. Now the question
is which of the two models is better? To some extent, this is an open question. The
general advice is first to look for a theoretical basis to inform your choice. If there are
strong substantive grounds for one model instead of the other, you should adopt it.
When it is not so clear theoretically, you can compare the model performance
parameters: the R-squared and Log likelihood. In our case, the spatial error model has
greater R-squared and Log likelihood values. That provides a statistical basis to adopt
this solution.

4. Another example

Now, do another exercise with % person below poverty as dependent variable, and %
non-Hispanic white, % non-Hispanic black, % college+ educated, unemployment rate, %
foreign born, and median household income as independent variables. Run OLS
regression, interpret the regression and spatial dependence diagnostics; if spatial
dependence exists, try to re-estimate the models with Spatial lag model and Spatial
Error model, then compare the output and make your choice.

In this session, we learned to use GeoDa to examine and control spatial dependence in
the regression models. By now, you should know the general strategy applied in GeoDa
to deal with the spatial dependence issue. You should be able to understand the various
diagnostics and regression tests, and able to interpret the results and make decisions
accordingly.
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